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Integrating a L440GX as a High-Performance File/Print Server

Assumptions
This installation procedure assumes the reader is installing Novell NetWare 5 on a system
built with an Intel L440GX Dual Processor Ready server with at least 64MB of memory.
In addition, it is assumed three new or unformatted hard drives are being used:  1 EIDE
hard drive for installation of the O/S, and 2 identical SCSI hard drives The first hard drive
for installing the O/S should be at least 1GB and the other three can be almost any
capacity as long as they are identical. Also, it is assumed that the onboard Adaptec AIC
7896 SCSI controller is used for controlling the SCSI devices.  The networking protocol
assumed for this installation is IP and the network adapter used is assumed to be the
onboard Intel 82559 Ethernet* adapter. The Intel 82559 on-board NIC is functionally
equivalent to the Intel EtherExpress  PRO/100+ network interface controller. Refer to
NetWare documentation for details on network protocols and other information if
necessary.

Note: No tape drive was integrated into the server system.  Intel strongly recommends
integrating a backup device and running routine backups on any server that is put into
production use by customers.  In addition, no UPS (uninterruptible power supply) was
integrated.  As with tape drives it is also strongly recommended that a UPS be used with
any server that contains critical customer data.

Hardware Integration Overview
v Install the L440GX Server board into the Server Chassis
v Install the Pentium II or Pentium III Processor(s) and/or termination cards on the

L440GX Server board.
v Install the Memory DIMM(s) on the L440GX Server board.
v Install the Floppy disk drive into the Chassis
v Install an IDE ATAPI CD-ROM drive into the bottom 5.25 external drive bay.
v Install the IDE and SCSI Hard Disk Drives into the Internal drive bay of the chassis.

Installing Novell NetWare 5
NOTE:
The NetWare operating system requires a minimum boot partition size of 50 MB. To
determine the optimal size of a boot partition, add the amount of server memory to the
minimum size of boot partition.  For example, a server with 64MB of RAM would have an
optimal boot partition of 114MB (64MB+ 50MB = 114MB).  The disk must also have
enough available space outside the boot partition to accommodate volume Sys. Most of
the NetWare products are installed on volume Sys, so you must have enough available
disk space to accommodate NetWare and all products to be installed.
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NetWare 5 Operating system 350MB Minimum Volume Sys
NetWare 5 with default products 450MB Minimum Volume Sys
NetWare 5 with all products 550MB Minimum Volume Sys
NetWare 5 will all products and docs 700MB Minimum Volume Sys

Pre-Installation Steps
A) Determine what protocol(s) this server will be running.  Assuming TCP/IP record

information below.
IP Address            ___________________________
Subnet Mask         ___________________________
Default Gateway   ___________________________
Server  Name      ___________________________

See Appendix C & D for additional worksheets
C) Power up your system and note at the initial screen what level of BIOS is installed.

The latest BIOS can be found at
“http://support.intel.com/support/motherboards/server/”.  Enter BIOS Set Up
(Press F2 during boot), Advanced Menu and confirm/set Multi-Processing
Specification to 1.4

Note:  The L440GX Server Board Resource CD also contains the System Setup Utility
and the product manual.  This CD can also be launched from within Win95 or NT to run
the graphical user interface (GUI).  In addition to all the functionality listed above, the
GUI provides more product and support information along with links to various Intel web
sites.

Access the Install files
1. Install the DOS CD-ROM driver for your CD-ROM device onto the boot
       partition. DOS CD-ROM drivers are provided by the CD-ROM manufacturer.

     NOTE: Make sure that the logical filename of your CD-ROM drive
     (specified in the config.sys and autoexec.bat files) is not CDROM or
     CDINST.

2. Make sure that the config.sys file contains the following commands: FILES=40
       and BUFFERS=30

Installation Steps from CD-ROM
1. Reboot the system with the DOS bootable disk.

2. Type FDISK at the command prompt and hit [Enter].
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3. (This will show you the current partition information on your hard drive.). Note
down the number of partitions on your hard drive. If FDISK shows an extended
partition, keep in mind that there are logical partitions within that extended partition.
Press [Esc] to get back to the Main Menu.

4. (This will allow you to delete your partitions. WARNING: This procedure is not
reversible.) If you had any extended partitions, delete the embedded logical partitions
by selecting [3]. Then delete the extended partition that contained the logical
partitions.

5. (This will allow you to delete your primary partition.). Finally, if you had any Non-
DOS partitions on your hard drive, delete them now by selecting [4].

6. Now that all existing partitions have been deleted, select [1] to create the primary
DOS partition from which to install NetWare. When prompted “Use maximum
partition size?” answer [No]. Enter in the partition size you wish to make. Leave all
other free space on the hard drive UN-partitioned.  NetWare system volumes will use
this remaining space. Select [2] from the main menu, and then select the primary
partition to be active. Quit FDISK.

7. To format the hard drive Restart the system with the DOS disk. Type FORMAT C:
/S at the command prompt and press [Enter]. This will format the hard drive and
transfer the system files from floppy to the hard drive.

8. After that copy all the necessary files from the floppy diskette to the hard drive (i.e.
CD-ROM drivers). Now remove the DOS Disk and restart the system from the hard
drive. This drive should appear as Drive C:. Run the Setup Utility for the IDE CD
Rom drive.  This drive should appear as Drive D:. The system is now prepared for
Novell  NetWare 5 Server installation.

9. Insert the NetWare 5 Operating System CD-ROM into the CD-ROM drive.

10. Change to the drive letter corresponding to the CD-ROM.

11. Type INSTALL <Enter>

12. Choose the language in which you want the server installed and press <Enter>.

13. The "Select the Type of Installation Desired" menu appears.

• New Server---If you are performing a new server installation, select New
      Server. The server installation will not delete system partitions or other partitions
      such as DOS, UNIX*, or Windows.
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• Upgrade---If you are upgrading an existing server from a previous version of
      NetWare, select Upgrade from NetWare 3.1 x or 4.1 x. Upgrading retains all
      your server data such as files, directory structures, partitions, and volumes.

• Startup Directory---The startup directory is the directory on the boot partition
that contains the files to launch the NetWare server.

14. Select the Regional Settings -- Choose the appropriate country, code page, and
keyboard mapping for your language and computer.

15. Select the mouse and video type – note: The mouse type and video type are not auto-
detected by the installation program. You must select the settings for the computer.

16. Select a platform support module -- A platform support module (PSM) provides
increased performance for multi-processor computers and some specific hardware
configurations.  When installing NetWare 5 on an Intel L440GX+ server system with
dual processors, NetWare will auto detect the correct PSM.

17. Select a PCI hot plug module – L440GX+ does not support hot plug PCI.

18. Select a storage adapter -- The storage adapter requires a software driver called a host
adapter module (HAM) to communicate with the computer (host). Storage devices
require a separate driver called a custom device module (CDM). The installation
program auto-detects many types of storage adapters, such as IDE and SCSI adapters.
The L440GX+ will detect the IDE and onboard AIC78U2 device.  (Note: for this
installation, the aic78u2.ham (9/11/98) aic78u2.ddi (9-10-98) along with the nbi.nlm
(8-29-97) were used.)

19. Select a network board – The on-board Intel 82559 device will be auto detected.  The
latest drivers for this board can be obtained from support.intel.com.

20. Create a NetWare Partition and volume Sys -- All available space on the storage
device will be allocated to the NetWare partition, unless you change the size. The
NetWare 5 operating system requires a volume of at least 350 MB named Sys.
Although the NetWare operating system requires only 350 MB, volume Sys must be
large enough to accommodate all of the NetWare products that will be installed.

21. NetWare system files will now be copied to volume Sys. The NetWare 5 installation
program will continue in graphical display mode.

22. Name the NetWare Server -- The NetWare 5 server name must be unique from all
other servers on the NDS tree.  The name can be between 2 and 47 alphanumeric
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characters and can contain underscores and dashes, but no spaces. The first character
cannot be a period.  NOTE: The server name should be different from the name you
plan to use for the NDS tree.

23. Install the NetWare Server File System -- The server should now have a single
NetWare partition and one volume named Sys. If you have space available for creating
additional partitions and volumes, you can create them now.

24. Create Volumes -- Additional volumes can be created from any available free space on
a storage device.  Volume names can be between 2 and 15 characters. Valid characters
include A through Z, 0 through 9 and characters _ ! - @ # $ % & ( ). The volume
name cannot begin with an underscore or have two or more consecutive underscores.
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A large disk can be divided into several volumes during installation. Conversely, a
volume can be distributed over multiple disks.  WARNING: Creating a volume that
spans two or more storage devices is not recommended. If a volume spans disk
devices and one of the devices fails, all data on the entire volume could be lost.

25. Mounting volumes -- In order for volumes to be accessed by NetWare, they must be
mounted. Volumes can be mounted immediately or at the end of installation.

26. Install the Network Protocol -- NetWare 5 can process IP network packets and
traditional IPX packets. You can install networking protocols in the following ways:

•      IP with IPX Compatibility Mode
•      Internet Protocol (IP) only
•      Internetwork Packet Exchange (IPX) only
•      IP and IPX
Protocols are assigned to network boards. Both protocols can be assigned to a single
network board, which allows the server to communicate using IP and IPX.
For the purpose of this guide, IP only was configured.
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27. Set the Server Time Zone -- The server time and time zone are important in order to
synchronize network events.  Advanced time synchronization settings are available
during the Customize section of the installation.

28. Set up NDS -- NDS, Novell's directory technology, provides global access to all
networking resources. NDS allows users with the proper access rights to log in to the
network and view and access network resources.  Network resources such as servers
and printers are presented hierarchically in an NDS tree. Users log in to the NDS tree
with a single login name and password instead of logging in to specific servers.

29. Choose the type of NDS -- To set up NDS, you must choose one of the following
options:

•      Install the server into an existing NDS tree
•      Create a new NDS tree

For the purpose of this installation, no other NetWare servers were installed, therefore,
the “Create a new NDS tree” option was used.

Each NDS tree must have a name unique from other NDS trees on the network. You
will also be prompted to create a user (default name ADMIN) with Supervisor rights,
identify an NDS context, and assign a password.

30. License the NetWare Server -- NetWare 5 must have a valid license in order to
function as a server. You can install the license from the NetWare 5 License diskette
or browse to a directory that contains NetWare 5 licenses.

31. Install other Networking Products -- After completing the NetWare server portion of
the installation, you can select other networking products to install. Other networking
products provide enhanced functionality to NetWare 5, such as network management
and Internet access.
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32. Complete the Server Installation -- The basic server installation is now complete.
Depending on which additional products you are installing, you might be prompted to
insert additional CD-ROMs.

Obtaining and installing the latest NetWare support packs:

The latest service packs and client software for Novell products can be obtained at:
http://support.novell.com/misc/patlst.htm

Installing the Support Pack

     During the NetWare 5 Support Pack installation, the following happens:
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     - The NetWare Support Pack files are copied to the server. Newer files on the server
are not overwritten. The installation program checks the version of each file. If two files
have the same version, the installation program then checks the date of each file.

     Note: Files in the \MISC directory are not installed automatically by the NetWare
Support Pack.

     - A record is added to the PRODUCTS.DAT file, in the "Installed Products" section,
and the following message appears: "SPACK 5.0.1 v1.0 Support Pack for NetWare 5."
Any other product updates are also listed.

     Prerequisites

     Before you install the NetWare 5 Support Pack, you must:

     - Unload JAVA.NLM and all Java applications to update JAVA.NLM and the Java
class libraries.

     - Load IPXSPX.NLM to install the NetWare 5 Support Pack in an IP-only
environment.

     - Have rights to the server console.

     - Make a record of your current SET parameter values. You can do so by loading
CONLOG,  typing "Display Modified Environment," and then unloading CONLOG.
Information will be saved to SYS:\ETC\CONSOLE.LOG, which you can use as a
reference. This NetWare 5 update contains a fix that resolves a problem with the registry.
As a result, SET parameters will revert to default NetWare 5 values the first time the
server is started after installing the Support Pack.  After the first start, SET parameters
will maintain their values.

     - Ensure that the NetWare 5 server is one of the following languages: English, French,
German, Italian, Japanese, Portuguese or Spanish.

     Installing the NetWare Support Pack

     Note: The Support Pack cannot be installed through the GUI installation.

     To install the NetWare 5 Support Pack on a single server, complete these steps:
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     1. To explode the file, type NW5SP1A and press Enter. Explode the file on the server's
volume SYS:, on another server volume, or on a local client that is using RCONSOLE to
run the installation.

     Note: This file contains directory paths that could exceed the DOS limits. The file must
be extracted in a root-level directory on your local drive or on a NetWare volume that
accepts longer paths.

     2. At the server console prompt, type NWCONFIG and press Enter.

     3. Select Product Options.

     4. Select Install a Product Not Listed.

     5. Depending on where the NetWare Support Pack files are located, complete one of
the following steps:

          a. From the local volume SYS:, press F3 and specify the path, including the volume
name (for example, SYS:\directory name).

          b. From a different server on the network, press F3 and specify the full path
including the server name (for example, Server_Name\VOL1:\directory name). You will
be prompted for a login name and password for the other server.

          c. From a local drive on a client using RCONSOLE, press F4.

     6. Press Enter.

     7. Press F10 to accept the marked options and continue.

     Note: If you want to be able to uninstall the Support Pack later, you must select the
option to back up files.

     8. Press Enter to end.

     9. After files are copied, review the .NCF files for accuracy.

     10. At the server console type "RESTART SERVER" and press Enter. This reboots
the server and completes the installation of the NetWare Support Pack.



15

Install NetWare Clients

Novell Client for Windows 95

Installing a new client
Run Winsetup.

     Winsetup.exe is at the root of the Z.E.N.works CD-ROM. The file automatically
     loads when you insert the Z.E.N.works CD-ROM.

   2.Click a language for the installation.

   3.Click a set of components to install, such as Windows 95 Components.

   4.Click Install Novell Client.

     Winsetup.exe launches setup.exe, which is in the products\win95\ibm_language folder.

   5.Accept the Novell License Agreement by clicking Yes.

   6.Click Typical > Install.

     Setup installs default settings including native IP protocol only.

   7.(Conditional) If prompted to select a network adapter, choose one that matches your
hardware.

     The Select Device dialog box displays a list. After you choose one, set the interrupt
(IRQ) and I/O address range. Note that asterisks help you avoid settings that conflict.

   8.(Conditional) If prompted to set a preferred server, preferred tree, name context, and
first network drive, click Yes, enter the information, and then click OK.

     For NetWare 3TM, set a Preferred Server. For NetWare 4TM, set a Preferred Server,
Preferred Tree, Name Context, and First Network Drive.

   9.Click one of the following:

          Reboot

          The new client and settings do not take effect until you do this.
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          Return to Windows

          Customize

          This option takes you to the Network control panel and allows you to install
optional components or     configure your workstation.

Upgrading a Previous Client

If you have earlier versions of Novell's 32-bit Client software, installation removes the old
software and installs the new version.

   1.Run Setup.

     Winsetup.exe. is at the root of the Z.E.N.works CD-ROM. The file automatically loads
when you insert the Z.E.N.works CD-ROM.

   2.Click a language for the installation.

   3.Click a set of components to install, such as Windows 95 Components.

   4.Click Install the Novell Client for Windows 95.

     Winsetup.exe launches setup.exe, which is in the products\win95\ibm_language folder.

   5.Accept the Novell License Agreement by clicking Yes.

   6.Click Typical > Install.

     Setup removes existing client software but retains settings in the registry.

   7.Click one of the following:

          Reboot

          The new client and settings do not take effect until you do this.

          Return to Windows

          Customize

          This option takes you to the Network control panel and allows you to install
optional components or configure your workstation.
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Novell Client for DOS and Windows 3.1x

Installing from the Network
After you create a network install directory, you can instruct your network users to run
either the DOS (install.exe) or Windows* (setup.exe) installation program from the
network to update the client software on their workstations.

1.Create a network install directory and then copy the doswin32 directory to it.
2.(Optional) Modify the setup.ini or install.cfg to supply default values for the installation
and to reduce or eliminate the need for user intervention.
3.Copy the modified setup.ini or install.cfg file to the network install directory.

User steps to be completed

Once you have modified the default values, instruct the users to complete the following
steps.

   1.Log in to the network.

   2.Map root a drive to the network installation directory.

     For example:

     MAP ROOT I:SYS:PUBLIC\CLIENT\DOSWIN32

   3.Do one of the following:

          If you are installing from Windows, make sure you are running Windows 3.1 x, and
then run winsetup.exe from the install directory.  If you are installing from DOS, make
sure you are in the directory, and then enter  install.

   4.If you are asked to provide information during the installation, follow the on-screen
instructions.

   5.Reboot your computer.

Installing from CD-ROM in Windows
   1.  Insert the Z.E.N.worksTM CD-ROM.

   2.Do one of the following:
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          In Program Manager, click File > Run, and then enter the path for the Novell
Windows setup program (winsetup.exe).  Switch to the CD-ROM drive and then double-
click winsetup.exe in the           appropriate director in File Manager.

     Winsetup.exe allows you to install additional software. It accesses the Novell Client for
DOS and Windows 3.1x install program (setup.exe).

   3.Click the language version you want to install.

   4.Click Windows 3.x > Install Novell Client > Yes.

   5.Follow the on-screen instructions to complete the setup.

   6.(Conditional) Based on the optional components you have chosen, you might have to
set up a Location Profile. If so, follow the on-screen instructions to complete this task.

   7.When Setup is complete, click Finish to restart the computer.

   8.(Conditional) If the Location Selection dialog box is displayed when the workstation
restarts, select a location.

     For more information on selecting locations, refer to the Novell Client online help.

   9.Start Windows and log in.

Installing from CD-ROM in DOS

   1.Insert the Z.E.N.works CD-ROM.

   2.From a DOS prompt, switch to the drive where the Z.E.N.works CD-ROM is located.

   3.Change to the Products\Doswin32 directory, and then enter install.

   4.Press Enter to accept the License Agreement.

   5.Select the options you want to install on the workstation.

   6.Press F10 to continue.

     NOTE: To return to the previous screen or to cancel the installation, press Esc at any
time before Install begins copying files.

   7.Configure the options you are installing.
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     Depending on the options you have chosen, various configuration screens  appear. Use
the arrow keys to move to a new field and press Enter to edit the field.

   8.Press F10 to save your changes and continue.

   9.Select 16-bit or 32-bit LAN driver type.

  10.Review the Installation Configuration Summary and make necessary changes by using
the arrow keys to move to a new field and pressing Enter to edit the field.

  11.Press F10 to continue.

     Install copies the appropriate files to your workstation and sets up the workstation to
run the Novell Client software.

  12.Exit Install by pressing Enter to return to DOS or by pressing Ctrl+Alt+Del to reboot
the workstation.

       The Novell Client software does not load until the workstation restarts.

Designing the Directory Tree Structure

Introduction:

The NetWare® Directory ServicesTM (NDSTM) technology allows you to develop a
common, distributed Directory database of logical and physical resources regardless of
where the resources are physically located---forming a single information system.

Applications that have traditionally maintained Directory databases such as e-mail, human
resources, and network management applications can now share a common source of
Directory information that is available from any server in the network. This greatly
enhances access to and management of resource information for the entire network.
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All NetWare 5 servers on the network access the Directory database for information about
network resources and access to those resources. Because of this, network information is
not server specific. Each network resource is represented by a unique entry in the database
and is accessed by its name, not by its association to a particular server.

All network clients access information and resources through a single connection to the
network.

NDS the Database:

NDS is an object-oriented implementation of a Directory that allows you to build
sophisticated naming schemes and logical representations of network resources. The
objects used in NDS are referred to as Directory objects.

Directory objects are structures that store information; they are not the actual entity
represented by the object. For example, a Printer object stores information about a specific
printer and helps manage how the printer is used, but it is not the actual printer itself.

The specific information that is stored for each object then becomes the directory
information that can be used by applications and resources across the entire network. The
Directory information is stored in the Directory database.

Directory objects consist of categories of information, known as properties or attributes.
These properties act as data fields within an object for defining specific information about
the object.

Some properties contain vital network information, such as printer names, network
addresses, and configuration information. Other properties contain non-vital information,
such as a user's job title, telephone number, and street address. The specific property
information is referred to as an object's property value.

Some property values are required. An object cannot be created without these values, and
these values cannot be deleted. For example, a User object requires both the name of the
object and a value for the user's last name.

Many properties are multivalued. This means that more than one value can be set for a
given property of an object. For example, values for multiple phone numbers can be set in
the Telephone Property of a User object.

Object Classes

The Directory database contains three types or classes of objects:
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* [Root] object (Directory tree name)
* Container objects
* Leaf objects
These objects represent both actual and logical resources in the network, such as users,
printers, groups, and print queues.

Directory Tree Design

The size of your network isn't as important as the environment your network exists in---
the network's hardware, communication links, LAN/WAN topology, and your
organization's structure.

The complexity of your network's physical and organizational infrastructure determines
the amount of designing necessary to efficiently implement the NDS technology---the
more complex your environment, the more designing you need to do.

For example, a small network with multiple WAN links might have many more design
concerns than a large network with no WAN links. This is because of unique physical
attributes associated with different WAN architecture types.

Generally, four types of network environments affect the design of a Directory tree:

Single server network  Typically maintains only LAN connections. The entire network is
housed in one building or office and all connections lead to a single server.

Single location network Typically maintains only LAN connections. The entire network is
housed in one building or office.

Single campus network Typically maintains only LAN or high speed WAN connections.
The entire network is located at one site, in one or more buildings.

Multiple campus network Typically maintains connections between campus sites. It relies
on data transmission across LAN and WAN links, with issues concerning speed and
volume.

Planning the Directory Tree Structure

NetWare Directory Services supports many different Directory tree structures. This
flexibility ensures that your tree design is the most efficient for your particular network
environment. To ensure that you build the most efficient structure, you should maintain
four goals:
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* Provide intuitive and efficient access to network resources.

* Provide secure access to shared resources that is easily maintained and monitored.

* Develop a clear and concise blueprint for completing the implementation process.

* Develop a flexible layout of the tree structure to ensure that future changes can be easily
incorporated.

The basic design principles provided in this section should assist you in accomplishing
these goals.

You should build your tree structure by actually drawing each layer of the Directory tree
as you read the following discussions. You can use modeling or drawing software, or
create diagrams of the structure on paper.

The most helpful documents for this procedure are organization and resource charts,
location maps, and WAN topology charts.

Setting Up Novell Distributed  Print Services
The following are the basic steps you must go through to create a new Novell®
Distributed Print ServicesTM (NDPSTM) printing system from the ground up. These
steps assume that you have already installed NetWare® 5TM on your server and a Broker
is running. (A Broker will already have been created during the installation process.

1. Create an NDPS Manager in NetWare Administrator.

     The NDPS Manager is used to create and manage server-based Printer Agents (similar
to the way PSERVER is used on servers to manage printing resources in legacy printing).
You must create an NDPS Manager on each server you will be controlling NDPS printers
from.

2. Create one or more NDPS Printer Agents.

     NDPS printers must be represented by a logical entity known as a Printer Agent.  No
Printer Agent can represent more than one printer, and no printer can be represented by
more than one Printer Agent.

     Unless your printer has an embedded Printer Agent, you will need to create one for
each printer.
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     The Printer Agent lies at the heart of NDPS, combining the functions previously
performed by a printer, print queue, print server, and spooler into one intelligent and
simplified entity.

     Any printer, regardless of its physical type or connection mode, can be configured as
either a public access printer or a controlled access printer

3.Install the latest version of Novell Client TM on each workstation that will be using
NDPS.

     The correct version of the Novell Client accompanies NetWare 5 and is required in
order for NDPS features to be available on your client workstations. Other clients can
print to NDPS printers through the backward compatibility feature, but only NDPS clients
can take full advantage of the advanced features offered by NDPS.

4.Install printers on individual workstations.

     You can do this in either of the following ways:

• Designate printers to be automatically installed on users' workstations through the
NDPS Remote Printer Management feature available through NetWare Administrator.

• Install printers manually on each workstation using the Novell Printer Manager
workstation utility, or the Windows* 95* or Windows NT* Add Printer function in
the Printers folder.

Creating an NDPS Manager
A Novell® Distributed Print ServicesTM (NDPSTM) Manager provides a platform for
Printer Agents that reside on the server. An NDPS Manager must be created as an object
in the NDSTM tree before you can create server-based Printer Agents.
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The NDPS Manager object stores information used by the NetWare® Loadable
ModuleTM (NLMTM), NDPSM.NLM. You can manually load this NLMTM at the
Server console, or it will be automatically loaded when you create a Printer Agent with
NetWare Administrator.

A single NDPS Manager can control multiple Printer Agents. (There is no hard limit.)

A specific NDPS Manager can be loaded only on one server. If it controls a local printer,
it must be loaded on the server the local printer is attached to.

A user creating an NDPS Manager must have at least Read, Write, Modify, and Create
rights for the container in which the object will be created.

While you can perform some configuration and management tasks directly through the
NDPS Manager console interface, NetWare Administrator is the main tool for performing
these tasks.

To create an NDPS Manager object, complete the following:

   1.In NetWare Administrator, select the container where you want the NDPS Manager
object to reside.

   2.From the Object menu, select Create.

     The New Object dialog appears.

   3.Select NDPS Manager.

     The Create NDPS Manager Object dialog appears.

   4.Type a name of your choice in the NDPS Manager Name field.

   5.Browse for the Resident Server where you want this Manager assigned.

     This can be any server in the current NDS tree in which you have installed NDPS. This
will be the only server you will be able to load this NDPS Manager on. The NDPS
Manager will store its database on a volume of this server.

6.Browse for the Database Volume where you want the NDPS Manager database
assigned.

     This must be a volume on the Resident Server you selected. This database will include
configuration data for all of the Printer Agents you assign to this NDPS Manager.
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Normally, volume Sys can be used with no problems. If this Manager will be controlling a
large number of printers, you should allow 3 to 5 MB of disk space for this function.

7.(Optional) Mark the Define Additional Properties box.

     If you do not want to add additional information or perform additional configuration
tasks for this NDPS Manager, skip this step.

 8.Click Create.

     If you marked the Define Additional Properties box, the NDPS Manager Details dialog
appears.

Creating NDPS Printers
After creating an NDPS Manager, you can create NDPS printers in any of the following
always:

• By using NetWare ® Administrator. If you are creating a controlled access printer, we
recommend that you use NetWare Administrator to create your new printers.

• By using gateways provided by third-party vendors. Some third-party gateways have
server-based utilities that can be configured to search for new printers attached to the
network and to automatically create Printer Agents to  represent them. For more
information about the gateways that ship with      NetWare 5 TM

• By using NDPSM.NLM at the server console. If you prefer to use the server console
to create your new public access printers using the Novell gateway.

Managing NDS objects:

Setting up NetWare Administrator on a Windows 95 Workstation

Prerequisites
o A workstation cabled to the network and running Windows 95* and Client 32TM
o 1.2 MB of free disk space on the workstation
o A drive mapping to SYS:PUBLIC on your preferred server
o Authentication to a NetWare Directory tree

Procedure

1.From the Windows 95 desktop, right-click and choose "New."
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2.Choose "Shortcut."

3.Choose "Browse."

4.From the Browser, locate the drive that points to SYS:PUBLIC and choose
NWADMN95.EXE.

5.Choose "Open."

Choose "Finish."

NetWare Administrator is created as a shortcut icon on your desktop.

You can now use the NetWare Administrator graphical utility to manage your Directory
tree.

Creating Directories Using NetWare Administrator

Procedure
1.Choose the "NetWare Administrator" icon from the Microsoft Windows (MS Windows)
Program Manager or the OS/2 desktop.

2.Using the browser, select the directory to be the parent directory of the one you want to
create.
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To create a root directory, select the Volume object. For more about moving around in
the browser and selecting objects, choose "Help" from the menu bar. For a list of
directories and files on a volume, select "View/Set Context" and specify the volume name.

3.Choose "Create" from the "Object" menu.

4.Enter the name for the new directory in the "Directory Name" box.

5.(Optional) Choose "Define Additional Properties" if you want to enter properties for the
directory.

Choose this item if you want to assign properties to the new directory now. You can also
add or modify properties after the directory is created. Properties include items such as
trustees and access rights.

6.(Optional) Choose "Create Another Directory" to create another directory immediately
after this one.

7.Choose "Create" to create a directory with the name you entered.

The new directory is created. You are returned to the browser.
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Appendix A: Detailed Equipment List

Hardware
Baseboard Intel L440GX Server Board
Processor 2 Intel Pentium  III microprocessors operating at 500 MHz
Memory (Always check approved memory list before buying DIMMS for your L440GX Server

Board) http://support.intel.com/support/motherboards/server/L440GX
SCSI Controller Integrated Adaptec AIC 7892 dual channel
NIC Integrated Intel 82559 controller (EtherExpress  PRO/100+)
Video Integrated
Hub Intel InBusiness  8 Port Fast Ethernet
IDE Controller Integrated dual channel IDE controller
Floppy Cont. Integrated floppy controller
Floppy drive TEAC FD235HF
CD-ROM IDE ATAPI Sony* CDU311 connected as master on 2nd IDE channel
Hard Drives
  IDE 1 Seagate* ST32132A – 2.1gig capacity
  SCSI 2 Quantum* Atlas II Wide, XP32275W  2.2gig capacity
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Monitor 15” Mag Innovision  Model NO:DX15FG
Mouse Microsoft 2-button PS/2
Keyboard Keytronic* 104 Key Model E03601QlPS2-C

Software
OS Novell® NetWare 5

Misc
BIOS: Production Release 2.0

Appendix C: The Server Worksheet
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Appendix D: The Workstation Worksheet:
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Appendix E:  Sample Network Directory Structure


